
READ ME FIRST!

ELECTRONIC ARTS PRESENTS

CD-ROM CLASSICS
SYSTEM SHOCK™

Warning to owners of projection televisions:
Still pictures or images may cause permanent picture-tube damage or mark the phosphor of the eRT. Avoid repeated or
extended use of video games on large-screen projection televisions.

EPILEPSY WARNING· PLEASE READ BEFORE USING THIS VIDEO GAME SYSTEM
OR ALLOWING YOUR CHILDREN TO USE IT.

Some people are susceptible to epileptic seizures or loss of consciousness when exposed to certain flashing lights or
light patterns in everyday life. Such people may have a seizure while watching television images or playing certain
video games. This may happen even if the person has no medical history of epilepsy or bas never had any epileptic
seizures.
If you or anyone in your family has ever had symptoms related to epilepsy (seizures or loss of consciousness) when
exposed to flashing lights, consult your doctor prior to playing.
We advise that parents should monitor the use of video games by their children. If you or your child experience any of
the following symptoms: dizziness, blurred vision, eye or muscle twitches, loss of consciousness, disorientation, any
involuntary movement or convulsion, while playing a video game, IMMEDIATELY discontinue use and consult your
doctor.
PRECAUTIONS TO TAKE DURING USE

Do not stand too close to the screen. Sit a good distance away from the television screen, as far away as the
length of the cable allows.
Preferably play the game on a small television screen.
Avoid playing if you are tired or have not had much sleep.
Make sure that the room in which you are playing is well lit.
Rest for at least to to 15 minutes per hour while playing a video game.



This document contains all the information that you
will need to get this game up and running. There are
important sections covering how to produce the
necessary boot disk, how to install and run your game,
a full key guide and instructions on how to use the
Adobe Acrobat on-line document reader.

For further information, the original manuals are
provided "on-line" on the CD. These can be read
using the included Adobe Acrobat on-line document
reader. To use this, see the section "Using the On-
Line Documentation".
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System Requirements
Computer. System Shock CD requires at least an Intel486 DX/33+ MHz or 100% compatible
system. and MS-DOS version 5.0 or higher.
Video Card. VGA or VESA compliant SVGA video card.
Hard Drive. You must have a minimum of 20 megabytes free on your hard drive to install and play
this game.
Joystick (optional). System Shock CD supports standard two-button joysticks, along with the
Thrustmaster Mark I. Flight Stick Pro and Gravis Phoenix.
Mouse. System Shock CD requires a Microsoft or 100% compatible mouse using Microsoft s:
software driver version 7.0 or higher or a 100% compatible driver.
Memory. System Shock CD uses 530K (542,720 bytes) of conventional RAM (base memory) and
at least 3072K (3,145,728 bytes) of extended memory (XMS). You must have a minimum of 4
megabytes of RAM installed in your machine to play from the CD without full speech or SYGA
graphics. You must have at least 8 megabytes of RAM to play ffom the CD with full speech and
SVGA graphics.

CD-Specific Features
The CD version of System Shock has several features that add to general gameplay.
If you have at least 8 ME RAM, you'll experience even more unique features, including full
speech for all logs and e-mails, and SVGA capabilities (with a compatible VESA driver).

Keystrokes. You have several keystrokes not necessary for gameplay. However, they are given
here for your reference:

~rn Displays enhanced features.

~ru Displays map coordinates and current video mode.

~ Cuts off speech sequence when logs or e-mails are playing.
VGA video modes. VGA video may be adjusted by selecting VIDEO from the Option Menu. You
have two VGA video modes available - 320x200 and 320x400. (YGA play recommended for
slower machines.)
SYGA video modes. If you have a monitor and card with SVGA capabilities and a VESA (or
equivalent bios) driver, you can play in SVGA by selecting VIDEO from the Option Menu. You have
two SVGA video modes available - 640x400 and 640x480.
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Audio capabilities. You can now experience digital sound effects through 2, 4 or 8 channels. Choose
AUDIO then AUDIO OPTIONS in the Option Menu to change the number of channels. You can also reverse
channels (if your speakers are switched).
Full speech. All logs and e-mails in the game have been recorded with full speech and ambient
sound effects. Certain station functions (such as buttons) also give audio messages.
VR Headsets. At the time of publishing, we had insufficient prototype information to document
headset operation. For information about how to use your VR headset (Forte VFXI or CyberMaxx)
with this game, contact the manufacturer.

Installation
Welcome to System Shock CD. This guide includes quick installation instructions for users familiar
with the installation process, and a detailed, step-by-step guide to installing the game. If you
experience any difficulty, consult Troubleshooting. To avoid compatibility or memory problems,
please take a moment to confirm that your machine matches the System Requirements. Do not use
System Shock CD with disk compression utilities. We cannot guarantee the compatibility of our
games with disk compression utilities, and you may corrupt saved games.
Note: Before installing any software, run chkdskfrom your DOS directory. This searches/or any lost allocation

chains (pieces of files). If any are found, please run a disk utility to correct these errors on your hard drive.
If you have DOS version 6.2, you can run scandisk tofu: any errors.

It's always a good idea to optimize and defragment your drive before installing new software. You can do so using

MS-DOS6.o or higher. At the C:>prompt, change to your DOS directory and type DFFRAG c: /F, then press 11 ENTER 11.

Quick Installation
1. Create a boot disk (see Creating a Boot Disk).
2. Insert your new boot disk into the A: drive and reboot your computer. Wait for the DOS prompt.

3. Type the name of your CD-ROM drive (usually D:), then press IIENTERII.

4. Type ORIGIN IIENTERII.

5. Press [IJJ to install System Shock CD. The installation menu appears.
6. Use the arrows to highlight the language you 'prefer (ENGLISH, FRANCAIS or DEUTSCH), then press

11 ENTER 11 twice.
7. When prompted, follow the installation steps. (See Installation Options.)
8. Press 11 ENTER 11 when the "Installation complete" message appears.
9. To begin play, switch to the game directory (default is C:\sSHOCK) and type CDSHOCK (for machines

with 8 or more MB RAM) or SS HOCK (for machines with 4MB RAM). Then, press IIENTERII.

4



10. To view/print the playguide and reference card. see Using the On-Line Documentation.

Installation Options
To change your sound and music card settings, rerun the Install program from the game directory.
If AUTO SETUP locks up your system, restart installation and select a different card or manually set
up your sound card with the proper settings.

Use m or m to move the highlighter up and down.

Note: To exit the installation without recording any selections, highlight quit and press 1ll!f!lI!J.
1-6. Follow Steps 1 through 6 of Quick Installation.

7. Highlight SETUP SOUND SYSTEM, then press IIENTER~.

8. Highlight CHOOSE MUSIC CARD, then press IIENTERII.

Use m or m to highlight the sound card that most closely matches your system, then press

11 ENTER 11·

Highlight AUTO SETUP if you want the program to detect the correct settings for the card you've

specified, and press 11 ENTER 11·

To choose settings manually. highlight MANUAL SETUP and press 11 ENTER 11. You must enter additional card
information. Unless you have modified the settings, the defaults suggested by the install program should
be correct.

110 port setting. This setting is normally 220.

9. Highlight CHOOSE DIGITAL CARD, then press IIENTERII.

Highlight the sound card that most closely matches your system, then press 11 ENTER 11.

Highlight AUTO SETUP if you want the program to detect the correct settings for the card you've

specified and press 11 ENTER 11. To choose settings manually, highlight MANUAL SETUP and press

11 ENTERII·
If you chose MANUAL SETUP, you will be prompted to provide additional card information.
Unless you have modified the settings, the defaults suggested by the install program should be
correct. The following menus handle this information. The settings available may vary between
different card types.
I/O port selling. This menu brings up a list of possible values. 220H is the default setting.
IRQ setting. This menu gives you a choice of 2,3,5,7 or other (5 is the default for all but the
oldest Sound Blaster cards; the oldest default to 7).



DMA setting. This menu gives you a choice of 0, I, or other (I is the default). Rap-10 users have
choices that combine two settings. The default setting is (5, 6). Others are (6, 7) and (7, 5) or other.

Press 11 ENTER ij after highlighting each configuration option. After you choose the DMA setting, you
will return to the Configuration Menu. (Some cards cause the program to choose the DMA setting
automatically.)

10. Highlight TEST MUSIC CARD, then press IIENTERI to test the configuration. If the card is detected,
you receive a message and hear music. If it does not match your hardware, an error message
appears. Press any key to stop the test.

11. Highlight TEST DIGITAL CARD, then press IIENTERI to test the configuration. If the card is
detected, you receive a message and hear a sound effect. If it does not match your hardware, an
error message appears. Press any key to clear the screen.
For more information on these settings, see your sound card documentation.
If you do not hear music or sound effects, even though the program says it detects your card,
try a different card configuration.

12. (Optional) To specify a game directory other than the default one (C:\sSHOCK), highlight

CHOOSE INSTALL DIRECTORY, then press jlENTER!. Type the desired drive and path, then press

ENTE again. If you skip this step, the game uses the default directory.

13. (Optional) Highlight OTHER OPTIONS and press IIENTER! to access joystick, cinematic and gameport
options.

14. Highlight JOYSTICK TYPE and press IIENTERII. Use m or m to highlight the type of joystick

you're using (or choose NO JOYSTICK), then press 11 ENTER 11 to return to the Option Menu.

Note: System Shock CD supports the Gravis Phoenix joystick. The game CD contains afile that will load a preset
list of commands. To load thisfile:

a. Copy SHOCK.PHX from the root directory of the CD into the Phoenix directory on your hard drive.
b. Switch to the Phoenix directory on your hard drive.

c. Type PHX SHOCK.PHX IIENTER 11 to load game-specific commands for the joystick.
15. (Optional) The game defaults to VGA for cinematic scenes. To change it, highlight CUTSCENE

TYPE and press 11 ENTER!.
Highlight SVGA to play cinematic rnidgames in high video resolution (if you have SVGA

capabilities), then press 11 ENTER 11· Or, highlight MCGA to display cinematic scenes in low video

resolution, then press IIENTERij.
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16. (Optional) If you have a gameport in your portable computer, highlight NOTEBOOKGAMEPORT.

This option defaults to DON'T CHECK.Highlight CHECK and press 11 ENTER 11.

17. When you are through changing options in the OTHEROPTtO S screen, highlight DONE and press

E TER to return to the Main Menu.
18. To exit installation and save the current configuration (without re-installing the game), highlight

SAVESETTINGSA D EXIT, then press IIENTER!.

19. To exit without installing or saving changes, highlight QUIT and press IIENTERI.
20. If you're satisfied with the options you selected, highlight INSTALLSYSTEMSHOCK and press

11 ENTER!. When installation is complete, you will receive a completion message. Press 11 ENTER I to
exit to DOS.

21. To begin play, switch to the drive and directory where the game is installed. Type CDSHOCK

11 ENTER 11 to start the game if you have 8 or more MB RAM; type SSHOCK 11 ENTER 11 if you have
4MB RAM.

Changing Your Sound Card Configuration
If you ever add a sound card (or change from one sound card to another), you must reconfigure the
sound card configuration for System Shock CD. Place System Shock CD in your CD-ROM drive.
Return to the drive and directory where you installed the game (for example, the default is

C:\sSHOCK) and type INSTALL,then press 11 ENTER I. This allows you to change the selections you
made when you first installed the game. Highlight SETUPSOUNDSYSTEMfrom the Configuration
menu and follow Steps 7 -11 in Installation Options.

You then need to highlight SAVESETTINGSANDEXIT, then press IIENTERI to save your sound card
changes. Once you start System Shock CD again, your new settings will take effect.

If You Have Trouble Installing
If you have not already, please review the System Requirements for System Shock CD to be sure
your hardware setup and System Shock CD are compatible.
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Memory Requirements
System Shock CD uses conventional RAM (base memory) and extended memory (XMS). Though
an expanded memory boot disk setup is included in Creating a Boot Disk, we recommend using an
XMS setup for optimal game performance. You must have a minimum of 4 megabytes of total
RAM installed in your machine. Of this memory, you must have at least 3072K (3,145,728 bytes)
free XMS memory to run System Shock CD using the SS HOCK executable. If you have 7168K
(7,340,032 bytes), you will get full speech and SVGA graphics (with a VESA-standard or
equivalent bios driver) when you use the COS HOCK executable file.

To find out how much DOS and XMS memory your computer has available, use the DOS MEM

command. From the DOS prompt, type: MEM I1 ENTER 11.

When the memory information is displayed on the screen, look for the following two listings:

LARGEST EXECUTABLE PROGRAM SIZE - this number indicates how much DOS conventional memory is
available. You must have at least 530K (542,720 bytes) listed here.

If you have DOS 5.0, look for this line:

BYTES AVAILABLE XMS MEMORY - this number indicates how much extended memory is available. You
must have at least 3072K (3,145,728 bytes) Listed here to play without full speech and SVGA
graphics (by running SSHOCK). You must have at least 7168K (7,340,032 bytes) listed here to play
with full speech and SVGA graphics (by running CDSHOCK).

If you have DOS 6.0 or higher, look at the last number in the memory table (last column):

EXTENDED (XMS) - the last number on this line indicates how much extended memory is available.
You must have at least 3072K (3,145,728 bytes) listed for this entry to run SSHOCK. You must have
at least 7168K (7.340.032 bytes) listed here to play with full speech and SVGA graphics (by
running COSHOCK).

If You Have Trouble Playing
If you are experiencing problems running System Shock CD or do not have the appropriate amount
of memory, it might help to create a separate boot disk and decrease the number of memory
resident programs (TSRs) you have loaded. Do not delete your AUTOEXEC.BAT or
CONFIG.SYS files from your hard drive - without them, your computer will not function.
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Using the On-Line Documentation
If you have Microsoft® WindowS® or Windows 95 installed, we recommend that you install the Windows version of the Adobe

Acrobat reader for greater ease of use when reading the on-line manuals. See below for instructions on installing Acrobat/or

Windows. If you have already installed the Acrobat reader from another CD-ROM Classics title, it does IIOf need to be re-

installed, skip to the To Start Adobe Acrobat for DOS or To Start Adobe Acrobat for Windows section.

DOS USERS:
System requirements for DOS:

386 or 486 based PC (486 recommended) •
DOS 5.0 or higher
2 MB of available RAM (4 MB or more recommended)
4 MB hard disk space
Microsoft-compatible mouse
VGA graphics card
Postscript or LaserJet printer supported

To install the DOS Adobe Acrobat on-line document reader:
1. Insert the CD in your CD drive.

2. Type 0: (or the letter of your CD drive. if different) and press E TER to move to the CD drive.

3. When you see the "0:" prompt. type ADOBE\ACRODOS\INSTALL and press ~ENTER!.

4. Follow the menu prompts to install the on-line documentation reader.

To start Adobe Acrobat for DOS:
1. The CD must be in the drive to run the program.
2. Move to the directory where Adobe Acrobat is installed. By default. it is installed in

C:\ACRODOS, so you would type:

C: IIENTERij

CD\ACRODOS IIENTER!

3. Type ACROBAT IiENTERi to start the program.

To open an on-line document file:
Select Open from the File menu. (The on-line documents are located on the CD-ROM
Classics CD.)
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Double-click on the D: (or appropriate CD drive leuer) from the DRIVE dialogue box.
Double-click on the language that you require.
Double-click on an on-line documentation file to open it.

To learn how to use Adobe Acrobat:

Open the file HELPREAD.PDF in the C:\ACRODOS directory on your hard drive. Complete Acrobat
instructions are contained in this file.

Windows 9S Users:

To install Adobe Acrobat for Windows:
I. From within Windows 95, Insert the CD in your CD drive. The CD must be in the drive to

install and run the program.

2. Click on the START button, and select RUN ...
3. Type d:\adobe\acrowin\acroread.exe (If your CD-ROM isn't drive 0:, substitute the

appropriate letter for '0'.)

4. Click OK or press ENT R and follow the instructions on your screen.

To start Adobe Acrobat for Windows:
I. Start Windows and ensure that the CD is in the drive.

2. Click on the START button.
3. Select Programs, Adobe Acrobat 2.0, and then Acrobat Reader 2.0

Windows 3.1X Users:

System requirements for Windows:

386-or 486-based PC (486 recommended)
4MB RAM
Microsoft Windows 3.1 or greater
To install Adobe Acrobat for Windows:
I. Insert the CD in your CD drive. The CD must be in the drive to install and run the program.
2. Start Windows.
3. From the Windows Program Manager, choose RUN ... from the File menu. The Run dialogue

box appears.
4. Type d:\adobe\acrowin\acroread.exe (If your CD-ROM isn't drive 0:, substitute the

appropriate letter for '0'.)

10



5. Click OK or press IIENTfRI and follow the instructions on your screen.

To start Adobe Acrobat for Windows:
I. Start Windows and ensure that the CD is in the drive.
2. If the Acrobat Reader 2.0 icon is not visible in the Program Manager window, double-click on

the Acrobat program group icon. The Acrobat window opens.
3. Double-click the Acrobat Reader 2.0 icon. The program begins.

To open an on-line document file:
Select Open from the File menu. (The on-line documents are located on the CD-ROM
Classics CD).
Double-click on the D: (or appropriate CD drive letter) from the DRIVE box.
Double-click on the language that you require.
Double-click on an on-line documentation file to open it.

To learn how to use Adobe Acrobat:
Open the file HELP _ R.PDF in the C:\ACROREAD\HELP directory on your hard drive.
Complete Acrobat instructions are contained in this file.

To print a document file:
Select Print from the File menu. Choose the range you want to print from the Print Range
dialogue box.
If you receive a "Acrobat does not support printing at this device resolution ..." message,
increase the resolution in the Print Quality dialogue box.
In DOS, prior to printing, go into Print Setup from the File menu. Choose Bitmap, which
will provide a list of available printer devices.
The Adobe Acrobat Document Reader does not support 9-pin printers.

Quick Acrobat Tips:
If you have difficulty viewing documents, click on the magnifying glass icon on the bottom of
the screen to increase resolution.
Each document file contains bookmarks that function as an electronic table of contents. To
view bookmarks, select Bookmarks and Page from the View menu. The bookmarks appear to
the left of the document window.
To jump to the page associated with a bookmark, double-click on the page icon next to the
bookmark.
To show or hide any subordinate bookmarks, click the triangle to the left of bookmark.
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To move through the document one page at a time click the Previous or Next Page buttons or

press the 1b3!E! cursor keys.
To move through a document one screen at a time, click above or below the scroll box in the

s~roll bar or press the ~~ keys.

Creating a Boot Disk
Before creating a boot disk, we recommend that you make a paper copy of your hard drive's

config.sys and autoexec.bat start-up files. Type at the DOS prompt: type config.sys IIENTER!

Either hand-copy or, if you have a printer, use ~ to generate a printout of this startup file. Now,

at the DOS prompt type: type autoexec.bat UENTERI

Hand copy or use to generate a printout of this startup file.
To create a separate boot disk, insert a blank high density disk in your A: drive. (Your computer

will not boot from the B: drive.) From the DOS prompt, type: format a: Is IIENTER!
After the disk is formatted, you must create a config.sys and an autoexec.bat using the
configurations below.

Modifying CONFIG.SYS
When the DOS prompt returns and the format is complete, type: edit a:\config.sys IIENTER!
When the new screen appears, type in the following commands:
CONFIG.SYS with XMS setup (no EMS driver)

DEVICE=C:\oOS\HIMEM.SYS
DOS=HIGH
FILES=45
SUFFERS=30
SHELL=C:\oOS\cOMMAND\cOM C:\OOS /p
DEVICE=c:\<path>\<your sound card driver> <parameters>

Type in the information for your sound card exactly as it appears on the printout of your config.sys
file. It should come from the sound card directory, e.g. c:\ss16\oRv\crMMSYs.SYs.

DEVICE=c:\<path>\<your CD-ROM driver> <parameters>
Type in the information for your CD-ROM driver line from the printout of the config.sys. It will
usually be a line containing the driver name (example: SBCD.SYS) followed by the device name of
your CD ROM (example: ID:MscDOOl).
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Exiting CONFIG.SYS
After typing these lines, you should exit and save your file. Do so by typing:

~ru
~
[J)]

Modifying AUTOEXEC.BAT
Next you need an autoexec.bat file on your boot disk. Type: edit a:\autoexec.bat liENTERY
When the new screen appears, type:

@ ECHOOFF
PROMPT$p$G
PATH=C:\oOS
c:\<path>\<your mouse driver>

Each mouse driver is loaded differently. See Mouse Setup.
<MSCDEX LINE>

Copy the MSCDEX.EXEline from your hard drive autoexec.bat file exactly as it appears.
<SOUNDCARDLINES>

Copy your sound card lines as they appear in your hard drive autoexec.bat. Include SET BLASTER,
SET SOUND,and any other lines that contain the sound card directory.

c:
CD\<game directory>

(The autoexec.bat file does not vary with different memory drivers.)
Exit and save this file by typing:

~rn
~
[J;!

To Use Your New Boot Disk
Turn your computer off, insert your new boot disk in your A: drive and turn the computer back on.
The boot disk should run and automatically take you into the System Shock game directory.
Installation Fails
If the installation should fail, an error message should tell you the nature of the problem. See
Troubleshooting for solutions to some common problems. If you continue having problems even
after creating a separate boot disk, try deleting the game from your computer and booting from the
boot disk. Then, reinstall the game from the CD. (Note that this will delete any saved games you
might already have.)
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Troubleshooting
If you have not aLready, please review the SystemRequirements for System Shock CD to ensure that
you comply.

Mouse and Joystick Problems
Q: Why won't my joystick work correctly?
A: Be sure that your joystick has been calibrated. (You may need to recalibrate it after you exit

cyberspace.) To do so, open the Option screen (Iml) and then click INPUT. Click CENTER

JOYSTICK, then place your joystick in the center position and press 11 ENTER 11. If this does not solve
the problem, contact ElectronicArts Customer Service. A speed-adjustable gamecard may help
solve joystick problems on high-end systems.

Q: My mouse is not working with System Shock. My mouse works with all of my other software
applications - why not with System Shock?

A: If your mouse does not work with System Shock CD, first check to see if your mouse has been
loaded in the autoexec.bat file you are booting from. It will be either on your boot disk (if you're
using one) or on your hard drive. Windowsand many other "rnulti-tasking" environments load their
own built-in mouse driver. These drivers will not operate outside of their shell environment.

Loading a driver into the DOS environment can be as simple as typing MOUSE11 ENTER 11 at the

command prompt. For example: C:\>MOUSE 11 ENTER 11

This command can differ from mouse driver software to mouse driver software. Consult your
mouse user's guide and Mouse Setup, for further details.

Memory and Configuration Problems
Q: System Shock exited to DOS with this error: "DOS/16M: [some number] cannot allocate

transfer buffer." What does this mean?
A: You have too many items loaded into your conventional (base) memory You must have at least

530K (542,720 bytes) free to play System Shock CD. If you're not using a boot disk, make one
using the steps listed in Creating a Boot Disk.

Q: System Shock threw me out to DOS with a fatal memory error. It said "Not enough memory."
What's wrong?

A: You are trying to play the game using the SSHOCKexecutable and have less than 3072K
(3,145,728 bytes) free extended memory (XMS), or you're using the CDSI-IOCKexecutable and
have less than 7168K (7,340,032 bytes) free extended memory (XMS).
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To find out how much memory you have, use the DOS command MEM and look at the BYTES

AVAILABLE XMS MEMORY line for DOS 5.0. For DOS 6.0 and higher, look at the EXTENDED XMS

line. It should indicate at least 3072K free extended memory. This is the amount of extended
memory available. If this number is less than 3072K, modify the autoexec. bat and config.sys
files on your boot disk. Refer to Creating a Boot Disk, for instructions on making a system boot
disk for System Shock CD.

Q: While I was playing System Shock, the game exited to DOS with this message: "Could 1I0t
find palette." How can [fix this?

A: The game needs more files than you have specified in your CONFIG.SYS. Follow the on screen
instructions and modify your boot disk files as indicated. You will then need to reboot your ••
system with the boot disk in the A: drive.

Q: Why does my computer crash when I try to play System Shock while I am logged into our
LAN (local area networks?

A: LAN software often tries to take over the same system resources that System Shock CD uses.
Sometimes the two can coexist, but often they can't. If you have strange problems with System
Shock CD while your LAN drivers are loaded, try booting from a clean boot disk that does not
load your LAN drivers. Please refer to Creating a Boot Disk.

Audio Problems
Q: I have a 100% Sound Blaster- compatible sound card, but I'm 1I0t getting allY sound. Why 1I0t?
A: Your sound card may have to be put into Sound Blaster emulation through its software or a

switch, or you may need to change the port configuration for your card (check your sound card
documentation).

Q: I have a Roland RAP-10 sound card. It was detected during installation, so why am I having
problems during gameplay?

A: (DMA channels) System Shock CD is one of the first games to support full stereo sound effects
and speech on the Roland RAP-1O card. The RAP- I0 does, however, require two available high
(16-bit) DMA channels, and one may be conflicting with a peripheral (such as a SCSI card or
network adapter). The install program defaults to DMA channels 5 and 6. You may wish to try
other DMA channel pairs. Some motherboard chip sets may not know how to handle high (16-
bit)DMA.

A: (IRQ setting) Looping or stuttering sound effects may be caused by an IRQ port conflict. If you
have changed your RAP-IO's IRQ default setting (9), you must manually configure System Shock
CD in the install program for the new setting. Some sound cards (such as the Creative Labs Sound
Blaster 16 and Sound Galaxy SC400) have their own MPU-401 MIDI interfaces that default to IRQ
channel 2.
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This can cause conflicts with both IRQ channels 2 and 9 on cards such as the RAP-IO. Simply
disabLing these MPU-401 interfaces may not be enough to avoid IRQ conflicts with the RAP-IO. If
problems persist, it may be necessary to remove the other sound card or change the RAP-I O's IRQ
jumper setting. Additionally, be sure that the I/O addresses are different between your RAP-I 0 and
your other sound card's MPU-401 interface.

Other Common Problems
Q: Why does my computer crash when / try to play System Shock through Microsoft Windows

(or OS/2, Desqview or DOS 5.0 Task Swapper)?
A: "Multi-tasking environments" - Windows, Desqview, Software Carousel, DOS 5.0 Task

Swapper and so forth - often conflict in their use of memory and other system resources with
System Shock CD. We do not recommend playing System Shock CD under these circumstances.
Even if you do run the game under a muJti-tasker, do not swap to another application while
playing. Your system may crash if you try to suspend System Shock CD to run another program.
In general, we recommend that you log out of Windows (or similar applications) and play from
the DOS prompt.

Q: After / play System Shock CD for all hour or two, the game seems to grow sluggish. Am /
imagining things, or is this a common problem?

A: Sometimes playing the game for an extended period of time does cause the program to slow
down. Save your game, then exit and power down your system. After a few minutes, restart
System Shock and load your saved game. This should solve the problem.

Q: Occasionally, / can't reload a save-game file. The game will load, but my machine locks up
or the game environment does strange things. Why?

A: Make a boot disk. Also, don't use a compressed drive (e.g., Double Space or Stacker). Because
games like System Shock CD frequently access the hard drive, disk compression sometimes
causes problems. ,

Q: System Shock stilldoesn't work after I made a boot disk and/or modified my config.sysand
autoexec.batfiles.

A: Copy down the error code and information the computer displayed when it quit to DOS. Then
see Electronic Arts Customer Service.
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Mouse Setup
Be sure that you are using a I(X)% Microsoft-rompatible mouse driver - a Microsoft version 7.0 or higher mouse
driver is preferable. If you are using a boot disk, this driver must be loaded within your boot disk configuration. Since
the command line may differ from mouse to mouse, consult your hard chive's autoexecbat by typing at the oos
prompt: type c:lautoexfC.bat. Look for your mouse driver line and copy it into your boot disk's autoexec.bat,
Consult your mouse user's guide for more detailed instructions on loading the mouse driver for your computer.

Disk Cache Programs
We do not recommend using a disk cache if you have less than 8 megabytes of free RAM. If you
have 8 MB or more of RAM and want to install SMARTDRVEXE (a disk caching program), we
recommend that you allocate 1024K of memory to the disk cache. We also recommend using the
SMARTDrive versions from Windows 3.1 or DOS 6.0. If you use a disk cache with only 8MB, you
may not have enough XMS memory available to run CDSHOCK, though SS HOCK should run fine.
Note: Though other disk cache programs may work with System Shock CD, we cannot guarantee compatibility.

On machines with more than 4 MB of free RAM, System Shock CD uses up to 2 more megs for
advanced features as long as that extra memory has not been allocated to a disk cache. If you install
SMARTDrive, add the following line to the beginning of your AUTOEXEC.BAT file. (You may also
need to change the path, depending upon where your disk cache program is located.)
C:\ooS\sMARTDRV.EXE 1024 C (The letter after 1024 should match the drive where the game is installed.)

1/0 and IRQ Ports
If you've selected an incorrect I/O or IRQ port setting for your music or sound card, sound and
music won't play and you'll get an error message when you test the card. The game may also lock
up. Type INSTALL IIENTER! from the game directory and re-install your sound system with
appropriate settings. (See Changing Your Sound Card Configuration.y

General MIDI
System Shock CD has joined the next generation of music quality with its support of the General
MIDI standard as defined by the MPU-401 instruction set. At the time of publishing, only a few
cards support MPU-401. These cards include Roland SCC-l, Roland RAP-IO, Ensoniq
Soundscape, Creative Labs Sound Blaster 16 with attached General MIDI daughterboard (such as
the Wave Blaster), and Creative Labs Sound Blaster ASP 16 with attached daughterboard. Other
manufacturers have already released, or are planning to release, sound cards that utilize the MPU-
40 I instruction set. However, sound cards that use a memory-resident program (TSR) to emulate
MPU-401 may not work with this software.
Note: Some General MIDI sound cards offer digitized speech or sound effect capabilities. Review your sound

card documentation or contact the manufacturer if you have any questions.
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Specific Sound Card Information
System Shock CD natively supports (without using emulation techniques) cards listed in this section.
However, some music and sound cards require you to load special drivers and/or choose specific ports:
Sound Blaster AWE32. The game natively supports the AWE Synthesizer chip located on your sound
card. You do not need to load any emulation drivers to receive General MIDI-quality music support.
Simply load AWEUTIL (from your sound card directory) in your autoexec.bat with its default parameters.
Also, select the same I/O port for music and digital sound effects.
ProAudio Spectrum. Although this game does not directly support ProAudio Spectrum, this card type can
use the Sound Blaster emulation mode to play music and sound effects. When using one of these, make
sure you have the drivers configured correctly for Sound Blaster emulation and that they are not loaded into
high memory.
If you have ProAudio Spectrum, select SOUND BLASTER for both music and digitized sound effects (during
installation). (Refer to readme.txt by running the install program and choosing VIEW README.)

Roland RAP-IO. System Shock CD is one of the fITStgames to use the Rap- IQ card for both sound and
digital effects. The CD version of this game supports both. If you're having problems with the game
locking up, or with sound effects looping or stuttering, you may have DMA or IRQ conflicts. Refer to
Audio Problems in the Troubleshooting section.
Ensoniq Soundscape. This game supports the Ensoniq Soundscape along with its General MIDI
capabilities. In your autoexec.bat, load SSINIT /1 (from your sound card directory) prior to starting System
Shock CD. Select 330 for the I/O port for music, 220 for digital sound effects. Choose an IRQsetting of 5
and a DMA setting of 1.
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REFERENCE CARD
Starting the Game
Enter the System Shock directory (default is C:\sHOCK). Type sshock and press IIENTERII. Type cdshock 11 ENTER 11

to run the enhanced CD version if you have 8MB RAM or more. Click on play intro, new game, credits or
continue (only appears after you save games). For new games, set difficulty levels (0 is easiest, 3 most
difficult), type your name and click START.

Manipulating Objects
Select item in Inventory/buttons in MFDs ...Left-click
Identify item in viewscreen
Activate side icon
Open lnventory/Mf'Ds
Fire .
Swing Weapon
Move .
Use item in viewscreen
Pick up item in viewscreen
Activate Inventory hardware
Place item in Inventory/MFDs

Use item on an object.

Activate Hardware
Discard item .

Throw item

Destroy useless item.

. Right-click

.Left-click-and-drag
........... Double-left-click (or ~-Ieft-click)

..1. Pick up item in viewscreen
2. Left-click on Inventory panel/Mf'D (or on Inventory button

in Full-Screen)
...........1. Use item in Inventory

2. Use object in viewscreen
...........1. Select Side Icon (or use from Inventory)

.......1. Select Inventory page button
2. Right-click on item name
3. Right-click in viewscreen

..... 1. Select Inventory page button
2. Right-click on item name
3. Right-click-and-drag in viewscreen
4. Release button

..1. Select Inventory page button
2. Select item name
3. Select item MFD
4. Select vaporize
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Cyberspace
Jack into cyberspace
Use software programs in Inventory
Identify.................. . .
Open Inventory/MFDs
Select Pulsar or Drill software in Inventory
Move . Left-click and hold or hold down SPACEBAR.

Pick up software and scan data. . Collide with item
Fire combat software . Right-click

.. Double-left-click (or 1IM!Il-left-click)on terminal .
......Left-click

Neural Interface

2-3. Inventory Panel
MAIN

HARDWARE

GENERAL ..

1. Viewscreen
2. Inventory Panel
3. Inventory Panel

button
4. MFD
5. MFD button
6. Side Icon
7. Cursor
8. Bio-Monitor
9. Health Indicator
10. Energy level

Indicator
11. Message Line
12. Posture Control
13. View Angle Control
14. Full-Screen Switch

..Weapons, grenades and patches
......Hardware attachments

........................................... Battery packs, first-aid kits, logic probes, etc.
.....Cyberspace software programsSOFTWARE

4-5. Multi-Functional Displays (MFDs)
Press the appropriate button to turn the display on/off.
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Left or Right MFD

[[j)jor~

~or~

IiYI or ~

~or~

Name

WEAPON

ITEM

AUTOMAP

TARGET

DATA

Function

Configures weapons for firing, shows arnmo types and heat levels.

Displays information about items in inventory.

Generates a map of the station as you explore.

Displays targeting hardware output and data about targeted
creatures.

Displays output from hardware/information about fixtures.
keypads. containers and corpses.

6. Hardware Side Icons
Press the appropriate button to turn the hardware on/off.
Left Side icons Right Side icons

!I! Bioscan (monitors biological state)

rn Full-Screen View (removes interface)

o Sense-around (360·degree view)

!4! Lantern (brightens dark areas)

m Energy Shield (provides body shield)

m Night Sight (infrared view attachment)

rnJ Navigation Module (electronic compass)

rn Multimedia Reader (e-rnail/log reader)

m Motion Boost (skates)

~ Jump Jet (flight boots)

8. Bio-Monitor
Frequent peaks indicate high levels. infrequent peaks represent low levels.
Light Red line ..Heart rate (relative fatigue)
Light Blue line Energy usage
Purple line Chi brain wave
Yellow line .Bio-contaminant exposure
Dark Blue line ...Radiation exposure

Weapons
Choosing a Weapon. Select (left-click) main Inventory button. Select a weapon. Open (left-click) either
weapon MFD to configure the weapon. (Or, use [!![l to cycle through weapons.)

Loading/Unloading Firearms. Select a weapon. then select an ammunition icon in the weapon MFD.
Unload by double-left-clicking.
Adjusting Beam Weapons. Move the MFD slider left or right to control intensity. Click OVERLOAD for
a powerful blast (drains more energy).
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Firing a Weapon. Place the cursor on top of the target (for firearms and beam weapons). Right-click to fire or
swing weapons.
Throwing Grenades. Select MAIN Inventory button. Double-left-click on a grenade name, then throw the
grenade. (place the mouse cursor over your target, then right-click.)
Applying Patches. Select MAIN Inventory button, then use (double-left-click) a patch name or click APPLY in the
ITEMMFD.

Automap
Left-click on either AUTOMAP MFD button.
Click on "-" to back the map out, click on "+" to zoom the map in.
Click FULL (lower right) for full-view (pauses the game and displays full-screen map and menu).
Click SIDE (lower left) for cross-section view of the station.

Option Menu

1. ~ (or left-click the upper lefthand corner of the screen)
2. Left-click option to change it/view sub-options

3. ~ or ~ to resume play

Joystick Commands
Move diagonally to combine movements. Use the mouse to move your cursor.

[ll Toggles mouse control over 10 joystick

m
.j.

El
~

Button #2 +8
Button #2 + ~
Button #2 + m
Button #2 + .j.

Trigger

Button #2

Walk/run forward (press slightly to walk,further to run)

Walk backward

Turn left
Turn right

Sidestep left
Sidestep right

Look up
Look down

Fire/swing weapon
Use item in viewscreen (door. puzzle, etc.)
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rn
m
El
~

Button #2 + GJ
Button #2 + l!3

Trigger

Cyberman Commands

Move, aim and fire by manipulating the Cyberman like a mouse - slide the device horizontally while
pressing the left and right buttons. The middle button combines with movement to control leaning and
view angle:

To lean, press the middle button and tilt the device left or right.
• To change your view angle, press the middle button and tilt the device forward or backward.

Cyberspace Joystick Commands

Dive or pitch downward
Climb or pitch upward

Bank left

Bank right
Rollleji

Roll right
Fire/swing weapon

Keyboard Commands
~ Run forward

m or m Walk forward

!M or m Walk backward

~ or B Turn left

[£i or Ell Turn right

~ or ~B Sidestep left

[£] or ~EIl Sidestep right

!£l] or I[QRlJIB Lean left (while standing or crouching)

m or IltfRjJlEIl Lean right (while standing or crouching)

~ Negate lean
SPACEBAR Jump

SPACEBAR rn or m Climb

Stand

Crouch
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m Prone

m or l©!illl[!lj Look up

oo-or 1©!ill1[Jdj Look down

leD Center view

~ and ~ Change Inventory page

~ and HIFT ~Cycle through weapons in Inventory

©!illl~ Display full-screen map

l©!illl~ Save game

IlQWII!IJ Load game

~ Exit game

~I!£! Display interface description

~[ElJ Activate on-line help

HIFT Ih1l Display on-line reference card

IIPAUSq Pause game

~ Open Option screen /Pause game

Cyberspace Commands

~ or [!lj Climb or pitch upward

~ or [Jdj Dive or pitch downward

~ or SPACEBAR Thrust or move forward

~ or B Bank left

[[g]] or!3 Bank right

~ or m Roll left

m or [£l] Roll right

IIENTERior right-click Fire software weapon
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Moving with a Mouse

To move, place your cursor in the viewscreen, then left-click-and-hold. The cursor location and shape
determines the direction of motion.
To increase speed, move the cursor away from the center of the viewscreen.

Fatigue. To rest, slow down, stop moving for a few seconds, or apply Staminup dermal patches.

~T...•WRNmTAND •••••••• •..Tt; TmRIGHTAN
l. MDVEfORWARO 1. SPRINT l. MOVE fORWAR

m •..+...• MOVT ~l. TURNlffT l. fORWARO l. TURNRI&HT

•.T...• •..T...•MOH •..T.•
1. SlIOTITfT t BACKWARO l. SlIDTRIGHT

~ BANKlffTAND I ClIMB rP BANK RIGHT
ClIMB ANOCllMB

«II 0 THRUST ItI>TURNlffT fORWARO TURNHIGHT

~
BANKlffTANU ~ \} BANIRIGHT

DIVT DIVT ANOUIVT

Climbing. Move face-first against a ladder or climbable wall. Click-and-hold both mouse buttons and
move forward.

View and Posture. Left-click in the View Angle Control and Posture Control boxes or use keyboard.

Option Menu
You must be playing the game to access the game options. To bring up the menu, press ~ or move your
cursor to the upper-left corner of the screen. You'll see "Click for Options." When you left-click in this
spot, the Option menu appears in your Inventory Panel.
SELECT (left-click) an option 10 change it.
SELECT the RETURN option or press ~ again to return to the game.

LOAD GAME C!@!JI!I!). Displays list of saved games. Select the game you want to load.

SAVE GAME C!@!Jm). Displays save game slots. Select a slot. then type a short description (up 10 30
characters) and press~.
AUDIO. Adjusts music and sound effects (not available if you haven't correctly configured your sound
card).

MUSIC. Adjusts music volume (left-click-and-drag the slider).
DIGITAL FX. Adjusts digital sound effects volume (left-click-and-drag the slider). Cards without digital
control will display a button that toggles sound ON/OFF instead.
AUDIO MESSAGES VOLUME. Adjusts volume of audio logs and e-rnails (left-click-and-drag the slider).
MESSAGES. Selects how e-mail and log messages display, either as TEXT, SPEECH or BOTH.
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VIDEO. Adjusts video display.
VIDEO MODE.Adjusts screen resolution. The highlighted buttons are modes supported by your video card. The
first two (320x200 and 320x4(0) are VGA modes; the other two (640x400 and 640x480) are SVGA modes that
require a VESA (or equivalent bios) driver.
GAMMA CORREcnON. Adjusts the overall lighting level (left-click and drag the slider left or right).
DETAIL. Adjusts level of graphics detail to MI jLowjHJGH/MAX. The MlN mode has a faster frame rate but has
lower-detail graphics. The MAX mode has a slower frame rate but high-detail graphics. (If you want a faster
frame rate while playing in MAX mode, don't remove the interface screen.)

OPTIONS.Accesses advanced options:
LANGUAGE. Cycles through English, French and German versions of text and speech.
ON-LINE HELP. Toggles on-line help ON/OFF.

TEXT LENGTH. Toggles between NORMAL/TERSE text (longer messages with extra fiction/abridged
versions containing only important info).
REfURN. Returns you to the main Option menu.

1Nl' T. Accesses other options.
pop-up CURSORS. Toggles the text cursors on the Lnventory and MFD buttons ON/OFF.

MOUSE HAND. Switches the LEFT and RIGHT mouse buttons.
CENTER JOYSTICK. Allows you to reset center position of joystick.
DOUBLE-CLICK. Lets you set double-click speed. Left-click-and-drag the slider left or right.
RETURN. Returns you to the main Option menu.

RETURN. Returns you to the game.
QUIT. Exits the game without saving.
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Technical Support
If, after thoroughly reviewing ALL the documentation, you are still having a problem with this software, please
read the following section.

Electronic Arts has a staff of customer service technicians ready to help you with any problems you may
encounter with the game. Electronic Arts Customer Service is available Monday to Friday during normal
business hours on (01753) 546465.

Today's PCs run with millions of different hardware and software combinations. Because of this, you may also
have to refer to your computer dealer or hardware manufacturer in order to properly configure their product to
run with our game.

When you call, if at all possible, be near your computer. if it is not possible, make sure you have the following
information ready:

The error message displayed when the problem occurred (if any).
A listing of your machine type and hardware contents, including CPU. sound and video board details.
The DOS version number you are currently running.
Your mouse and driver type.
The contents of your CONFIG.SYS and AUTOEXEC.BAT files.
Your CD-ROM drive type and CD-ROM extensions version, if fitted.
The contents of a CHKDSK and MEMjC statement

Or you may write to us at the following address, including the above information.

Electronic Arts Customer Service, P'O. Box 835, Slough, Berkshire, England SL3 8XP

Notice
Electronic Arts reserves the right to make improvements in this product described in this manual at any time and
without notice.

This manual, and the software described in this manual, is under copyright All rights are reserved. No part of
this manual or the described software may be copied, reproduced, translated or reduced to any electronic medium
or machine-readable form without the prior written consent of Electronic Arts Limited, 90 Heron Drive, Slough,
Berks SL3 8XU, England.

Electronic Arts makes no warranties, conditions or representations express or implied, with respect to this
manual, its quality, merchantability or fitness for any particular purpose. This manual is provided "as is".
Electronic Arts makes certain limited warranties with respect to the software and the media for the software. In
no event shall Electronic Arts be liable for any special, indirect or consequential damages.

These terms and conditions do not affect or prejudice the statutory rights of a purchaser in any case where a
purchaser is a consumer acquiring goods otherwise than in the course of a business.
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Limited Warranty
Electronic Arts warrants to the original purchaser of this computer software product that the recording media on
which the software programs are recorded will be free from defects in materials and workmanship for 90 days
from the date of purchase. During such period defective media will be replaced if the original product is returned
to Electronic Arts at the address on the rear of this document, together with a dated proof of purchase, a
statement describing the defects. the faulty media and your return address.

This warranty is in addition to. and does not affect your statutory rights in any way.

This warranty does not apply to the software program themselves, which are provided "as is", nor does it apply
to media which has been subject to misuse, damage or excessive wear.

N.B. Media Replacement Notice
Electronic Arts are NOT able to replace damaged media once the 9O-day limited warranty has expired. This
notice supercedes the Media Replacement Notice on the on-line documentation.

R8985CEY
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